ABOUT THE REPORT TEMPLATE

This template may be used during the writing of your doctoral dissertation or may be used once you have completed your writing work and you transfer it into the template file that will then be used for submission to the Graduate School, K-REx (K-State Research Exchange), and ProQuest.  (ProQuest is for doctoral students.) The final PDF that you submit is generated from the Word template to ensure formatting. Please review the notes in this document and the resources located on the K-State’s ETDR website.

Why a doctoral dissertation template?  This template ensures proper formatting of the contents of a doctoral dissertation, so all the required information is present and in the proper format and order.  This template also ensures easy navigation through the electronic file, when clicking on items in the Table of Contents or List of Figures or List of Tables will jump a reader directly to the proper location in the file.  The contents of this template also show an informational hierarchy based on the text styles and order.  As such, the contents are both human- and machine-readable. 

Most up-to-date version of MS Word installed.  Please make sure that you have the most up-to-date version of Microsoft Word from the K-State provided Microsoft Office 365. 

Live Web links.  Another way to ensure proper navigation is to make sure that your http links are activated.  You may just need to add/click one space after the URL, and MS Word will turn it into a link for you.  

Font type changes.  In general, use the given font in the template.  However, if you are determined to change the font, change it in one location, by changing it in the Word text Style for Body Text.  Do not highlight text manually and change the font, it will not be applied consistently in the template. 

Handling digital images.  This template was set up so that all inserted images are not compressed inside Word (so they retain high resolution quality).  The setting is High Fidelity. For images, please use .jpg format.  If image resolution is of particular importance, go with less lossy digital image formats like .png or .tif.  Typical image standards for publication are 350 dpi at minimum.  Color for print is CMYK format (vs. RGB for web). While your template initially begins as a Word file, it will ultimately be saved as a.pdf file for digital archival and distribution which retains these image details.

Bibliographic citations.  Different disciplines have different standards for citing sources both in-text and in the bibliographic listing at the end.  These standards also determine labeling for figures and tables.  It is important to be correct and consistent in the citations.  

List of Abbreviations / List of Terms / List of Equations?  Some works contain a list of abbreviations.  Where these are placed and how they are formatted depend on the discipline.  For some disciplines, the List of Abbreviations follows the List of Tables.  For others, this list may appear elsewhere in the formal thesis.  The formal sequence to place anchors for the respective elements would be the sequence:  References tab -> Captions -> (Object).  
Proper name of student on the Copyright page and proper file name format.  The format for your filename is FirstnameLastnameYYYY.pdf.  Note the capitalization of the first and last name and the lack of any blank spaces in the name. The year is represented with four numbers.  An example would be WillieWildcat2024.pdf.  In some cases, various middle names or middle initials may be included. 

An important thing is to ensure that your name in the file name and copyright matches what is in KSIS as your official name. Log into KSIS.  Go to the Profile file.  Check your “Primary” name and ensure that that is what is used in the ETDR file. Note on the Copyright page there are spaces. 

[bookmark: _Hlk43198765]Supplementary files.  You may need to include related slideshows, articles, datasets, image sets, and other related contents.  These are not added to the document but can be included during your submission of your thesis into K-REx and ProQuest.  Sometimes, students want to embed data tables and datasets in Word. These do not carry over into the .pdf file so should be included separately. 

Maximum .pdf size.  There is a 10 GB size limit for ETDRs on K-REx and ProQuest.  Note that this is the size of a compressed .pdf, which is often a lot smaller than the Word file.  

Omitting blank pages.  Please review your manuscript and remove any blank pages. You may need to adjust the spacing before Page Breaks to move them up and eliminate a blank page. Make sure that the new pagination in your Table of Contents is correct with an update after your remove pages.  

A bound print copy of your work.  To obtain a personal bound copy of your manuscript, see the option at https://www.k-state.edu/grad/academics/etdr/write/#bound 

Highlighted notes.  In this template, there are some highlighted parts (in yellow) to further explain how the template works, along with these instructions.  All highlighted text and formatting notes should be deleted before finalizing your file.  

Field shading.  The grayed parts of the template highlight field shading for automated parts of the template.  Do not type directly into these fields.  The chapter and section titles and caption labels in these gray fields are auto generated from the use of Word Styles (Headings 1-9, and Captions). You type your text in the document, the apply the appropriate heading or caption style, and then they appear in the Table of Contents and Lists of Figures and Tables. 

What breaks an MS Word template?  One thing to avoid, as mentioned above, is editing or typing directly into the gray shaded field areas in the Table of Contents and Lists of Figures and Tables. To ensure that Field Shading is enabled. For a Windows PC, go to the Word File menu > Advanced options and go down to Field shading and select “Always”.  For Macs it is Word menu > Settings > View options > Field Shading: Always. This will turn all field coding in gray text.  

[image: Graphical user interface, text, application

Description automatically generated]

Additionally, never highlight body text in the ETDR and change the font type or size.  All the styles of text—Header 1, Header 2, body text, block text, captions, and others, are controlled by Word.  If you want to change the text appearances across the board for that type of text, go to the Styles pane and use the dropdown to the right of the style and “Modify.”  Do not have styles that have addendums like “body text + boldface + …”  The plusses should not be used because that leads to inconsistencies in your document.  

Never edit the Table of Contents, List of Figures, or List of Tables. The table style (and navigation) is built into the template.  Customizing the table style has often led to a broken template.  

Now, if you’ve been working on your document and broken the template somehow or things do not look right to you, take a deep breath. You do not have to worry.  All you need to do is download a blank template from the K-State Graduate School website, and carefully move your contents over to the new template.  

Copy and then paste in your text and apply the Heading styles to chapter and section titles. Apply the template Body text style to your paragraphs.  Insert images using Word, do not copy and paste.  Make sure that the images are .jpg, .png or .tif.  If you have tables, use Excel to scrub out the unnecessary formatting.  Use Excel to control for table width if the table width is wide (9” or so). Then copy and paste the table into Word. Place the table in a landscape format if needed.   

Then follow the directions to process your ETDR to final format.  It usually only takes an hour or so to copy and complete an ETDR in a working template.  

Help and support.  Some common challenges with Word files are described with solutions in the linked article.  If you need any help, please contact the IT Service Desk at servicedesk@ksu.edu or 785-532-7722.  Please reach out early to have questions addressed, so that you are not rushed to finalize your work.  

(02.2024) 


Your title here in sentence case (descending case)


by


Your Official Name (as appears in KSIS record)



(previous degrees with punctuation, format, and date order, as shown in example below)
B.S., Kansas State University, 2010



A REPORT



submitted in partial fulfillment of the requirements for the degree



(degree being earned in all capital letters, or BLOCK CAPS, as shown in examples below)
MASTER OF ARTS
MASTER OF SCIENCE



Name of your department (example: Department of Chemistry)
Name of your college (example: College of Arts and Sciences)



KANSAS STATE UNIVERSITY
Manhattan, Kansas
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[bookmark: Copyright]Copyright
© Firstname Lastname YYYY.




Abstract (or Executive Summary)
An abstract does not have a size limit at K-State as of 2017.  (In MS Word, just highlight your abstract, and a count will be available at the bottom left of your workspace.)
The executive summary highlights the main ideas of the report contents to be read by the executive receiving the report (traditional) and used by general readers to better understand the main points of the report.  
If you delete any lines on this page, KEEP the hidden Section Break below that controls page numbering.  How to see it:  Home tab > Paragraph section > click the[image: ]icon.  (On a Mac, the icon may be above the ribbon.)








Table of Contents
No more manually typed Contents!  The “...” entries below come from your content.
1. Apply Heading 1, 2, 3 styles in your document to organize your content. 
2. In the list below, right-click on any line with “...” and select Update Field.
3. Whenever a window pops up, select Update entire table and click OK.
Delete this highlighted text before you publish.

List of Figures	viii
List of Tables	ix
Acknowledgements	x
Introduction	1
Background (or Review of the Literature)	4
Methodology	5
Results (or Findings)	7
Discussion	8
Conclusion (or Recommendations)	9
References or Bibliography (choose one)	10
Appendix A - Using appendices, adding more, adding captions	12
Appendix guidelines	12
Adding Appendix figure/table captions	12
Adding an Appendix Figure caption item	13
Adding a new table to the List of Figures/Captions for appendix captions	13
Appendix B - Your Appendix B title here	16
Glossary of Terms	18


[bookmark: _Toc159513231]List of Figures
The List of Figures is created from figure captions in this document.  
 1. In your chapters, insert figure captions. You must train them (1, 2, 3, or 1.1, 1.2, 1.3, etc.). 
2. Update the list below. Right-click anywhere in the list and select Update Field. 
3. If a window pops up, select Update entire table and click OK.  

Figure 1.  Global Prevalence of SARS-CoV-2 Mid-June 2020 (from WHO)	1
Figure 2. A Flowchart of Processing a Thesis, Dissertation, or Report from Word to PDF	6

Appendix Figure A.1.  An appendix image example	15
Appendix Figure B.1.  Another appendix example here	16
Appendix Figure B.2.  A PDF inserted as an example	17


[bookmark: _Toc159513232]List of Tables
The List of Tables is created from table captions in this document.  
 1. In your chapters, insert table captions. You must train them (1, 2, 3, or 1.1, 1.2, 1.3, etc.). 
2. Update the list below. Right-click anywhere in the list and select Update Field. 
3. If a window pops up, select Update entire table and click OK.  

Table 1.  COVID-19 Cases by Race / Ethnicity (CDC, June 16, 2020)	2
Table 2.  Median Household Income in State of Oklahoma from 2009 - 2013 (from data.gov)	2



[bookmark: _Toc159513233][bookmark: Acknowledgements]Acknowledgements
The Acknowledgements page is optional.  If you include it, retain the Acknowledgements heading and enter your text here. 




9


[bookmark: _Toc159513234][bookmark: Chapter1]Introduction
This section contains the aims and objectives of the report.  
If you delete this page or any lines on it, KEEP the hidden Section Break below that controls page numbering.  How to see it:  Home tab > Paragraph section > click the[image: ]icon.  (On a Mac, the icon may be above the ribbon.)

[bookmark: _Toc159513248][bookmark: _Hlk43027892]Figure 1.  Global Prevalence of SARS-CoV-2 Mid-June 2020 (from WHO)
[image: ]

Digital images should be rendered at 350 dots per inch (dpi) or pixels per inch (ppi) for sufficient resolution and even higher depending on the focal points of the image.  Also, they should be in .jpg format for size.  If image resolution is of particular importance, go with less lossy digital image formats like .png or .tif, and you can use a much higher resolution (some have 1200 dpi/ppi in some images. The aspect ratios of the figures should not be distorted or stretched.  Images should not be pasted in from the clipboard but inserted from the Insert tab in MS Word.  
[bookmark: _Hlk43033195]The template “anchors” are linked to the captions for the Figures and Tables.  When a person navigates to a figure or table (from the List of Figures or the List of Tables), their page will show the respective target object.  Notice that the figures and tables begin with the respective chapter based on auto-numbering (References tab -> Captions area).  

[bookmark: _Toc159513253]Table 1.  COVID-19 Cases by Race / Ethnicity (CDC, June 16, 2020)
	Cases by Race/Ethnicity

	Date generated: Tue Jun 16 2020 11:45:37 GMT-0500 (Central Daylight Time)

	
	
	

	Race/Ethnicity
	Percentage
	Count

	Hispanic/Latino
	16.1
	292206

	American Indian / Alaska Native Non-Hispanic
	0.6
	11181

	Asian Non-Hispanic
	1.9
	33889

	Black Non-Hispanic
	10.4
	189964

	Native Hawaiian / Other Pacific Islander Non-Hispanic
	0.1
	2637

	White Non-Hispanic
	16.8
	304817

	Multiple/Other Non-Hispanic
	2.1
	37765

	Unknown
	52
	946298




[bookmark: _Toc159513254]Table 2.  Median Household Income in State of Oklahoma from 2009 - 2013 (from data.gov)
	Years
	Historical Data
	Target

	2009
	$41,664.00 
	

	2010
	$42,072.00 
	

	2011
	$43,225.00 
	

	2012
	$44,312.00 
	

	2013
	$45,690.00 
	

	2014
	
	

	2015
	
	

	2016
	
	

	2017
	
	$51,424.00 





[bookmark: _Toc159513235]Background (or Review of the Literature)
This section contains the aims and objectives of the report.  
[bookmark: _Toc159513236]
Methodology
Add your content here. 





















[bookmark: _Toc159513249]Figure 2. A Flowchart of Processing a Thesis, Dissertation, or Report from Word to PDF 

[image: Diagram
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[bookmark: _Toc159513237]Results (or Findings)


Add your content here. 


[bookmark: _Toc159513238]Discussion


Add your content here. 



[bookmark: _Toc159513239]Conclusion (or Recommendations)


Add your content here. 






[bookmark: _Toc159513240]References or Bibliography (choose one)
Include a separate chapter for your references or bibliography.  Citations can be single- or double-spaced (but consistent).  They must be followed by a blank line.  The rest of the format is entirely up to you and your adviser.
The Bibliography style does not format your citations into a specific style such as American Psychological Association (APA), Modern Language Association (MLA), Chicago Style, or others.  You must enter your citations in the style used by your department, or use bibliographic software such as RefWorks, EndNote, or Mendeley.  
If using a cloud-based bibliographic software, be sure to update all of your sources.  Ensure that these are accurate.  Make sure to update the versions of your work in all installed versions on different machines.  In MS Word, bring in your sources.  Reconcile any broken links (or failed intake of particular sources).  Then, highlight the entire list, and apply the Bibliography style.  This style means that all sources are single spaced, and there is a blank line between each entry.  If there are broken lines, backspace from the front of the dangling lines so that the entries show correctly in the Bibliography.  
For assistance with citations, contact K-State Libraries (at www.lib.k-state.edu) and see its Citations and Bibliographies information at guides.lib.k-state.edu/citations.
Below are examples of a Bibliography style in this template (single spacing, hanging indent, a blank line afterward, and a rough right edge).  It meets the needs of many students.  You can modify it as needed to meet departmental requirements.

Devine, P. G., & Sherman, S. J. (1992). Intuitive versus rational judgment and the role of stereotyping in the human condition: Kirk or Spock? Psychological Inquiry, 3(2), 153-159.
Hodges, F. M. (2003). The promised planet: Alliances and struggles of the gerontocracy in American television science fiction of the 1960s. The Aging Male, 6(3), 175-182.
James, N. E. (1988). Two sides of paradise: The Eden myth according to Kirk and Spock. In D. Palumbo (Ed.), Spectrum of the fantastic (pp. 219-223). Westport, CT: Greenwood.




Appendix A A.1Appendix B A.1

[bookmark: _Toc159512307][bookmark: _Toc159513241]Using appendices, adding more, adding captions
[bookmark: _Toc488433402][bookmark: _Toc159512308][bookmark: _Toc159513242]Appendix guidelines
· Appendices are optional.  If you use them, there is no limit on the number of appendices. 
· Use Heading 6 to define appendix titles. Appendix subheadings are organized by using Headings 7, 8, and 9 in the Word Styles.
· Adding more appendices by inserting a Page Break (Insert > Page Break), so the next appendix starts on a new page. Then type the appendix name and apply a Heading 6 style (Home > apply style Heading 6). Word will add the “Appendix” label and correct alphabetical sequence.
· Make sure to update your Table of Contents to include your new appendices.
· Captions for figures/ tables in appendices are not required to be in the List of Figures but can be included as an option.
· If captions are included in the main document and are numbered as 1, 2, 3, etc., that numbering format should continue through your appendix captions.  If captions in chapters are numbered to include chapter numbers 1.1, 1.2, 1.3, etc., your appendix captions must match that format by using A.1, A.2, A.3, etc.
[bookmark: _Toc159512309][bookmark: _Toc159513243]Adding Appendix figure/table captions
Adding a caption to a figure or table is the same as doing it within a chapter. However, the template does not contain Appendix caption labels nor will they appear in the existing List of Figures and List of Tables as they cannot be saved as a template and you can’t combine two different caption labels in one list in Word.  We will fix that by having you do 2 things:
1. You will create and caption your Appendix Figures and Tables with new caption labels that you will create following the steps below.
2. Then you’ll insert another List directly after the current List of Figures and List of. Tables, and that second List will pull in appendix captions. 
[bookmark: _Toc159512310][bookmark: _Toc159513244]Adding an Appendix Figure caption item
1. There isn't already an "Appendix Figure" label, so we will create one. You cannot create one without inserting it as well so go to the Appendix A, figure #1.  With the 1st item selected, click Insert Caption on the References Word menu.
2. Click the "New Label" button and call it "Appendix Figure". Then click OK
3. With the "Appendix Figure" label selected, click the "Numbering: Format..." button
4. Set "Chapter starts with style:" to Heading 6 (This is our Appendix number/letter) and the Separator to a (.) Period. Click OK.
5. Then set the Position to Above Selected Item, then OK again. Do not add your caption text here. You will do that once the caption label is added.
6. That will insert the Appendix Figure A.1. caption.
7. Then, enter or paste in your caption text and click OK.
8. You can repeat this to create an Appendix Table label if needed.

Once that is done we need to add a whole new List of Figures at the top, to display these new captions.
[bookmark: _Toc159512311][bookmark: _Toc159513245]Adding a new table to the List of Figures/Captions for appendix captions
1. Scroll to your existing List of Figures
2. Toggle on the Show/Hide Formatting icon to show invisible characters, so you can see the "Page Break" below your List of Figures.
3. Place your cursor directly below the last item in your List of Figures and before the Page Break.
4. From the References tab (and next to the Insert Caption.. button), click the Insert Table of Figures button.
5. In the window that appears, select "Appendix Figure" from the "Caption label:" list.
6. Click OK.

This will add a second List of Figures below your original one, but this one will be populated with Appendix Figures. Repeat this under your List of Tables if needed. Remember that you now have two fields to update as you make changes -- the List of Figures/Tables and the second list that appendix figures/tables below the first one.

You might notice that there's a paragraph character between the two fields. If you delete that, the formatting of your Appendix Figures list will be thrown off. Instead, our recommendation is to carefully select JUST that one paragraph character and set the font size for it to something very small, like 2 point. This will tuck the Appendix Figures up closer to the Figures. 

You caption just as you did in the chapters except that you select Appendix Figure or AppendixTable as the label. 
1. First select the figure or table you want to caption.
2. Go to Word Reference menu then Insert Caption. You can also find Insert Caption in the mouse right click (or two finger click) menu. 
3. Select Appendix Figure as the label. Confirm the Position as Above the selected item and then click OK. Don’t type your caption text here. Type it after the label is inserted.
4. That will insert the caption label, as in the example below.
[bookmark: _Toc159512565][bookmark: _Toc159513442]Appendix Figure A.1.  An appendix image example
[image: A person with large intestine
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5. Then type a period (.) and 2 spaces and then you can type your caption.
Then do this to each of your figures in Appendices.   They should show up labeled with the correct letter of each Appendix like A.1, B.1., C.1, etc.

Now you need to update the List of Figures with the Appendix captioned items. Reminder that there are actually two different List of Figures/Tables, one for the chapters and one for the appendices as Word can’t combine two different caption labels in one list.
Make sure you update this 2nd List of Figures by right (or two finger) clicking on the correct area and choosing Update Table.

[bookmark: _Toc159512312][bookmark: _Toc159513246]Your Appendix B title here
Your appendix content goes here.  
[bookmark: _Toc159512566][bookmark: _Toc159513443]Appendix Figure B.1.  Another appendix example here
[image: A close-up of a logo
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[bookmark: _Toc159512567][bookmark: _Toc159513444]Appendix Figure B.2.  A PDF inserted as an example
[image: ]


[bookmark: _Toc159513247]Glossary of Terms
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BULLETIN 
DU 



Musée royal d'Histoire 
naturelle de Belgique 



Tome XII, n° 45. 
Bruxelles, décembre 1936. 



MEDEDEELINGEN 
VAN HET 



Koninklij k Natuurhistorisch 
Muséum van België 



Deel XII, nr 45. 
Brussel, December 1936. 



CRUSTACÉS DÉCAPODES NOUVEAUX OU PEU CONNUS 
DE L'ÉPOQUE CRÉTACIQUE, 



par Victor V A N S T R A E L E N (Bruxelles). 



Les notes rassemblées ici se, rapportent à, des Crustacés 
Décapodes crétaciques, se trouvant dans diverses collections 
officielles ou privées. Il m'a été permis d'examiner ces précieux 
fossiles, grâce à l'obligeante confiance des confrères ayant la 
garde des collections. Ils sont trop nombreux pour être cités 
tous, mais qu'ils veuillent bien trouver ici l'expression de ma 
reconnaissance. 



Tout a été mis en œuvre pour condenser le texte de ces notes. 
Seules les formes nouvelles sont l'objet d'une description. Les 
espèces crétaciques, connues antérieurement à cette publication 
et reconnues dans ces collections, ne sont citées que si elles pro-
viennent de localités où, jusqu'à présent, leur existence n'a pas 
été signalée. 



Sous-ordre des REPTANTIA. 
Section des Palinura. 



Tribu des ERYONIDEA. 
Famille des ERYONIDAE. 
Genre ERYON D E S M A I I E S T . 



Eryon sp. 
(Pl. I, fig. 1.) 



D E S C R I P T I O N . — Depuis la fin du Jurassique, les Eryoniclae 
sont extrêmement rares. On connaissait déjà Eryon neocomiensis 











Bull. Mus. Roy. Hist. Nat. Belg. - T. XII, no 45, 1936. Pl. IH. 
Mededeel K. Natuurh. Mus. Belg. - D. XII, m 45, 1936. 



Fig. 7. 
Prosopon 



icaunensis 
Van Straelen. 
Type. Gr. nat. 



Fig. 8. — Prosopon icaunensis 
Van Straelen. 



Type, x 3. 



Fig. 6. — Galatheites 
neocomiensis Van Straelen. 



Type, x 6. 



Fig. 2. — Homarus pelseneeri Van Straelen. 
Type. Gr. nat. 



Fig. 5. 
Galatheites 



neocomiensis Van Straelen. 
Type. Gr. nat. 



Fig. 1. — Enoploclytia 
glaessneri Van Straelen. 



Type. Gr. nat. 



Fig. 3. — Homarus 
pelseneeri Van Straelen. 



Paratype. Gr. nat. 



Fig. 4. — Homarus trigeri 
(A. Milne-Edwards MS.) Topotype. Gr. nat. 



V. VAN STRAELEN. - Crustacés Décapodes Crétaciques, 











GOEMAERE, Imprimeur du Roi, Bruxelles. 

















